Notices and Trademarks

Copyright 2010 by Honeywell Inc.
March 2010

While this information is presented in good faith and believed to be accurate, Honeywell disclaims the implied warranties of merchantability and fitness for a particular purpose and makes no express warranties except as may be stated in its written agreement with and for its customers.

In no event is Honeywell liable to anyone for any indirect, special or consequential damages. The information and specifications in this document are subject to change without notice.

Honeywell is a U.S. registered trademark.

Other brand or product names are trademarks of their respective owners.

Honeywell Inc.
Honeywell Process Solutions
2820 West Kelton Lane
Phoenix, AZ 85053-3028
1-800 852-3211
About This Document

Revision Notes

The following list provides notes concerning all revisions of this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>March 10</td>
<td>Updated for Windows 7</td>
</tr>
<tr>
<td>March 09</td>
<td>Windows Vista Tips and Notes added</td>
</tr>
<tr>
<td>1/28/09</td>
<td>Updated for Windows Vista.</td>
</tr>
<tr>
<td>05/08</td>
<td>Redesign the SCT 3000 software to replace the PCMCIA Interface with the Honeywell’s DE / HART Modem</td>
</tr>
<tr>
<td>03/00</td>
<td>Serial interface capability and STT150 support.</td>
</tr>
</tbody>
</table>

References

The following list identifies all documents that may be sources of reference for material discussed in this publication.

<table>
<thead>
<tr>
<th>Document Title</th>
<th>Doc ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMV 3000 Smart Multivariable Transmitter User's Manual</td>
<td>34-SM-25-02</td>
</tr>
<tr>
<td>ST 3000 Smart Transmitter Release 300 User's Manual</td>
<td>34-ST-25-14</td>
</tr>
<tr>
<td>STT 3000 Series STT250 Operator Manual</td>
<td>EN11-6190</td>
</tr>
<tr>
<td>STT 3000 Series STT150 Operator Manual</td>
<td>EN11-6248</td>
</tr>
<tr>
<td>MagneW 3000 PLUS Electromagnetic Flowmeter</td>
<td>36-KI-25-02</td>
</tr>
</tbody>
</table>
Contacts

World Wide Web

The following lists Honeywell’s World Wide Web sites that will be of interest to our industrial automation and control customers.

<table>
<thead>
<tr>
<th>Honeywell Organization</th>
<th>WWW Address (URL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corporate</td>
<td><a href="http://www.honeywell.com">http://www.honeywell.com</a></td>
</tr>
<tr>
<td>Honeywell Process Solutions</td>
<td><a href="http://www.honeywell.com/ps">www.honeywell.com/ps</a></td>
</tr>
</tbody>
</table>

Telephone

Contact us by telephone at the numbers listed below.

<table>
<thead>
<tr>
<th>Organization</th>
<th>Phone Number</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>United States and Canada</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Honeywell Inc.</td>
<td>1-800-343-0228</td>
<td>Sales</td>
</tr>
<tr>
<td>Industrial Automation and Control</td>
<td>1-800-525-7439</td>
<td>Service</td>
</tr>
<tr>
<td>Asia Pacific</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Honeywell Asia Pacific Inc.</td>
<td>(852) 8298298</td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Europe</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Honeywell PACE</td>
<td>[32-2] 728-2111</td>
<td></td>
</tr>
<tr>
<td>Brussels, Belgium</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Latin America</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Honeywell Inc.</td>
<td>(305) 364-2355</td>
<td></td>
</tr>
<tr>
<td>Sunrise, Florida U.S.A.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Symbol definitions

The following table lists those symbols used in this document to denote certain conditions.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="CAUTION symbol" /></td>
<td>This CAUTION symbol on the equipment refers the user to the Product Manual for additional information. This symbol appears next to required information in the manual.</td>
</tr>
<tr>
<td><img src="image" alt="WARNING symbol" /></td>
<td>This WARNING symbol on the equipment refers the user to the Product Manual for additional information. This symbol appears next to required information in the manual.</td>
</tr>
<tr>
<td><img src="image" alt="WARNING symbol" /></td>
<td>WARNING: risk of electrical shock. This symbol warns the user of a potential shock hazard where HAZARDOUS LIVE voltages greater than 30 Vrms, 42.4 Vpeak, or 60 VDC may be accessible.</td>
</tr>
<tr>
<td><img src="image" alt="ATTENTION symbol" /></td>
<td>ATTENTION, Electrostatic Discharge (ESD) hazards. Observe precautions for handling electrostatic sensitive devices</td>
</tr>
</tbody>
</table>
# Contents

SMARTLINE CONFIGURATION TOOLKIT  SCT 3000

1— Introduction ........................................................................................................... 1
   Smartline Configuration Toolkit ............................................................................. 1
   Field Devices Supported ......................................................................................... 2
   SCT 3000 Features .................................................................................................. 3
   National Language Support ...................................................................................... 4

2— System Requirements .......................................................................................... 5
   Before You Begin ..................................................................................................... 5
   Computer Requirements .......................................................................................... 5
   Software Compatibility ............................................................................................ 6
   SCT Hardware ........................................................................................................... 7

3— Software Installation ........................................................................................... 11
   SCT 3000 Installation .............................................................................................. 11
   SCT 3000 Software Application and Setup ............................................................ 11
   CD ROM Installation ............................................................................................... 12

4— Hardware Installation .......................................................................................... 15
   SCT Hardware .......................................................................................................... 15
   DE / HART Modem ................................................................................................. 15
   DE / HART Modem hardware assembly and installation .......................................... 16
   Serial Hardware Interface (for use with STT 150 only) .......................................... 19

5— Start up and Working Online ............................................................................... 22
   SCT 3000 Application ............................................................................................ 22
   Getting Online Quickly ........................................................................................... 22
   SCT 3000 Features .................................................................................................. 28

6— Working Offline ................................................................................................... 33
   Using the SCT 3000 Offline .................................................................................... 33

7— Online Help ......................................................................................................... 37
   Online Help Features ............................................................................................... 37

8— Some Vista and Windows 7 Tips and Notes: ....................................................... 39

9— Troubleshooting ................................................................................................. 43
   Overview .................................................................................................................. 43
   Troubleshooting SCT Application and the hardware .............................................. 44
   Troubleshooting SCT 3000 Operation .................................................................... 44
   SCT Error Codes ..................................................................................................... 47
   Status Bar ................................................................................................................ 50
   Modem Maintenance ............................................................................................... 52
   Honeywell’s Technical Assistance Center .............................................................. 54
Appendix A ................................................................................................................55
Appendix B ................................................................................................................56
Glossary ....................................................................................................................57
Index .......................................................................................................................... 59
Tables

Table 1  SCT 3000 Computer Specifications - Minimum Requirements ................................................... 5
Table 2  DE / HART Modem Hardware Specifications ......................................................................... 7
Table 3  Serial Hardware Interface Specifications ............................................................................... 8
Table 4  SCT 3000 Application Installation from CD ROM .................................................................. 12
Table 5  DE/HART Modem connections to a field device .................................................................... 23
Table 6  Starting the SCT 3000 Application ....................................................................................... 25
Table 7  Help Menu Selections ........................................................................................................... 37
Table 8  SCT 3000 Installation Troubleshooting Table ....................................................................... 44
Table 9  SCT Error Codes and Descriptions ....................................................................................... 47

Figures

Figure 1  SCT 3000 Smartline Configuration Toolkit Overview ........................................................... 2
Figure 2  SCT 3000 Banner Window .................................................................................................. 26
Figure 3  SCT 3000 Application Window .......................................................................................... 28
Figure 4  Online Operation Setup .................................................................................................... 29
1— Introduction

Smartline Configuration Toolkit

Honeywell’s Smartline® Configuration Toolkit, SCT 3000 provides a cost-effective and efficient means to configure, calibrate, diagnose and monitor Honeywell’s Smart field devices. The SCT 3000 is an engineering and maintenance software application designed for ease-of-use and increased productivity. The SCT 3000 runs on a Windows™-based personal computer specifically to support Honeywell’s Analog and Digitally Enhanced (DE) protocols in nonhostile, general-purpose field environments.

Toolkit Contents

Check to make sure that the SCT 3000 components in your purchase order are included in your shipment box:

1. SCT 3000 software media
   Application CD ROM “Honeywell SCT 3000 Smartline Configuration Toolkit”
   Version 5.11.302 for Windows 98, 2000 Operating Systems

2. Hardware interface options

   If you ordered the DE / HART Modem module with RS-232 cable option, you should have:
   • DE / HART Modem
   • RS-232 Pass-Through cable
   • Adapter cables (1 with alligator clips; 1 with easy hooks)

   If you ordered the DE / HART Modem module with RS-232 cable and the Accessory item (USB to RS-232 Converter option), you should have:
   • DE / HART Modem
   • RS-232 Pass-Through cable
   • Adapter cables (1 with alligator clips; 1 with easy hooks)
   • USB to RS-232 Converter
   • Detachable Extension Cable
   • Driver Software CD
   • Driver software installation instructions (34-ST-33-61)

   If you ordered the serial hardware interface, you should have:
   • Serial hardware interface module
   • Interface Cable with connectors on both ends
3. Paper documentation

SCT 3000 Start-up & Installation Manual (34-ST-10-08)

Note: An individual order may differ from this list as allowed by the Model Selection Guide. For example, you may have opted to omit the SCT 3000 Start-up & Installation Manual from your order.

Field Devices Supported

The SCT 3000 operates and communicates with the following Honeywell Smartline field devices:

- **ST 3000** Smart Pressure Transmitter *
- **ST 3000** Smart Pressure Transmitter with integral meter
- **STT 3000** Smart Temperature Transmitter, (includes Series STT150, STT250 and STT350 transmitters)
- **SMV 3000** Smart Multivariable Transmitter
- **MagneW Plus**

* Note that the SCT 3000 will not communicate with older ST 3000 transmitters that are analog only and contain software version 2.2 or earlier, or version 6.1 or earlier.

The **SCT 3000 Online User Manual** provides useful configuration and diagnostic information for the supported field devices. More detailed information for configuring and operating these field devices is found in separate user manual and operating guide documents that support each field device. See References on Page iii in the front of this document for a list of these documents.
SCT 3000 Features

The Smartline Configuration Toolkit has all of the following features:

- Windows-based software application allows easy access to all Smartline configuration and calibration device parameters.
  - Employs familiar Windows tools that include an online user manual and context sensitive help.
  - Device database parameters are arranged and presented in logically grouped “tab card” displays.

- Online and Offline Mode operation
  - Offline mode allows you to configure and save database files for various devices without being connected to the device.
  - In the online mode you can download the saved databases to the devices and perform online functions such as:
    - Selection of the Communications Mode (Honeywell DE or analog)
    - Configuration and device diagnosis
    - Calibration
    - Display of device parameters
    - Device check out

- Built-in Database Templates
  - Default database templates are provided for each type of field device to simplify and reduce implementation time and effort.

Database Verification

- Database parameters are checked for “reasonable” values automatically to help avoid mistakes.
- A database compare function detects differences between the device database and the SCT database providing assurance of proper installation.

- PV Monitoring
  - Graphical representations of device inputs and outputs are shown in a window so you can monitor the operating status of Smartline field devices.
  - Window shows you values of input PVs, output PVs and SVs of the connected device in real time.

- Flow Wizard
  - A built-in wizard that provides considerable time savings and ease of use for you when configuring the flow process variable in a Smart Multivariable Transmitter (SMV 3000). By providing responses to configuration questions and choices in a step-by-step progression, you can configure the flow variable (PV4). Upon completion, a configuration solution is generated by the wizard that can be saved as a database file and downloaded to the field device.
Windows operating system references

SCT 3000 will be supported in two versions. Version 5.11.302 is based on the Windows 98 and Windows 2000 Operating Systems. Version 5.12.265 is based on the Windows XP, Windows Vista Business, Windows Vista Ultimate and Windows 7 Operating Systems. Before you begin to use the SCT 3000 know how to perform basic operations with your computer and with Windows. The information and procedures presented in this manual assume you are already familiar with Windows. If necessary, you may find it useful to review the following reference manuals from Microsoft before proceeding:

- *Getting Started with Microsoft Windows* - a guide to setting up Windows on your system and a brief introduction to Windows.
- *Microsoft Windows User’s Guide* - provides a comprehensive description of Windows; includes explanations and procedures for first-time users, in addition to topics for advanced users.
- *Microsoft Windows Tutorial* - provides online instructions for using a mouse and for performing some basic tasks in Windows.

National Language Support

The SCT 3000 now provides language support for English, French, Spanish, Italian, and German. The language support feature will display the SCT application window, the associated tab cards and parameter field labels in the selected language. During installation, the SCT 3000 setup program identifies the regional settings of the computer and automatically selects the appropriate language support. If the regional settings are not one of the supported languages, then English is installed as the default language. Please note that the online Help and online User Manual will still be displayed in English.
2— System Requirements

Before You Begin

Before you install the SCT on your computer and start using it, there are a number of system requirements for the computer you will be using that will ensure trouble-free installation and operation with the SCT 3000 application.

Computer Requirements

The SCT 3000 software application runs on a variety of commercially-available portable or desktop computer platforms that may also be shared with other applications. Table 1 lists the system capabilities needed to install and operate the SCT 3000 application.

Table 1  SCT 3000 Computer Specifications - Minimum Requirements

<table>
<thead>
<tr>
<th>PC Specification</th>
<th>Computer:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Laptop or Desktop PC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PC Specification</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Pentium 90 MHz or better</td>
</tr>
<tr>
<td>Display</td>
<td>SVGA (Monochrome or Color)</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 98, 2000 (SCT version 5.11.302)</td>
</tr>
<tr>
<td>Pointing Device</td>
<td>Mouse or trackball-compatible device</td>
</tr>
<tr>
<td>Power Source</td>
<td>Battery powered (see Note 1)</td>
</tr>
<tr>
<td></td>
<td>AC powered (see Note 1)</td>
</tr>
<tr>
<td>Laptop PC</td>
<td>Battery powered (see Note 1)</td>
</tr>
<tr>
<td>RAM</td>
<td>16 MB (32MB recommended). See Note 2.</td>
</tr>
<tr>
<td>Application Size</td>
<td>12 MB (application) + 5 kB per database file</td>
</tr>
<tr>
<td>CD ROM Drive</td>
<td>4x or higher</td>
</tr>
<tr>
<td>Laptop PC</td>
<td>4x or higher</td>
</tr>
<tr>
<td>Desktop PC</td>
<td></td>
</tr>
<tr>
<td>Ports</td>
<td>Parallel: Printer (see Note 4)</td>
</tr>
<tr>
<td></td>
<td>Serial: For STT150 support and DE / HART modem support for all the other devices (See Note 3)</td>
</tr>
<tr>
<td></td>
<td>USB Port: For STT150 support and DE / HART modem support in case the Serial port is not supported on the Laptop or PC (See Note 5)</td>
</tr>
</tbody>
</table>

NOTES:

1. Computer power source (and laptop PC’s battery charger and/or AC adapter) must be suitable for worldwide use: 50-60 Hz and 100-220 VAC operation; also, battery should provide enough capacity to power the PC Card without derating life by more than 10%.
2. Minimum RAM capacity is 4 MB, but ROM-based portable PCs may be able to run with only 2 MB.
3. These functions require laptop PCs to have a serial port for communications.
4. SCT 3000 software supports any Windows 98 (or greater)-compatible printer.
5. To use the SCT 3000 on a desktop computer without serial port, you must install USB to RS-232 Converter Driver Software. See the Installation Instructions sheet (34-ST-33-61)
Computer Models for use with SCT 3000

The Dell models with the following Operating Systems have been performance-qualified by Honeywell for use with the Smartline Configuration Toolkit.

SCT 3000 product version 5.11.302 supports:

- ·Microsoft Windows 2000, 5.00.2195 Service Pack 4
- ·Microsoft Windows 98, Second Edition 4.10.2222A

SCT 3000 product version 5.12.265 supports:

- ·Microsoft Windows XP Professional Version 2002, Service Pack 2
- ·Windows Vista Business
- ·Windows Vista Ultimate
- ·Windows 7

Software Compatibility

The SCT 3000 may coexist with the following application programs on a computer.

- Microsoft Office Tools.

The import/export capabilities of SCT database files allow for only “tab” delimited text files.

Refer to Appendix B in this document for further information on software compatibility.
SCT Hardware

Communication between a computer running the SCT 3000 application and the field device is accomplished through one of two hardware interfaces:

1. The **DE / HART Modem** is used to talk to all Honeywell field devices supported by the SCT 3000, (except the STT 150). See Table 2 for specifications.

2. A **Serial Hardware Interface** is used only when communicating to the STT 150 smart temperature transmitter. See Table 3 for specifications.

Each of these hardware interfaces is described in Section 4, *Hardware Installation*.

Environmental specifications for SCT hardware

The SCT is designed to operate in a non-hostile, general purpose field environment. It is important to operate the SCT in an environment that is within the ranges for temperature, humidity, shock and vibration that are specified in Table 2 and Table 3.

**WARNING**

The SCT 3000 is not certified for use in hazardous locations.

### Table 2 DE / HART Modem Hardware Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication Protocol</strong></td>
<td>Compatible with Honeywell Smart Field Network (SFN).</td>
</tr>
<tr>
<td><strong>Temperature Range</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>-10 °C to 50 °C</td>
</tr>
<tr>
<td>Storage</td>
<td>-20 °C to 60 °C</td>
</tr>
<tr>
<td><strong>Operating Humidity Range (RH)</strong></td>
<td>10-90%</td>
</tr>
<tr>
<td><strong>Shock Range</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>5 G, 50ms</td>
</tr>
<tr>
<td>Storage Range</td>
<td>15 G, 11ms</td>
</tr>
<tr>
<td><strong>Vibration Range</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>0.2 G (0-100 Hz, 0.75 mm-P-P)</td>
</tr>
<tr>
<td>Storage Range</td>
<td>0.5 G (0-100 Hz, 0.75 mm-P-P)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>0.45lbs (approx)</td>
</tr>
<tr>
<td><strong>Approval Bodies</strong></td>
<td><strong>EUROPE</strong></td>
</tr>
<tr>
<td></td>
<td>European EMC Standards:</td>
</tr>
<tr>
<td></td>
<td>EEC Directive 89/336 (EMC)</td>
</tr>
<tr>
<td></td>
<td>CE Mark</td>
</tr>
</tbody>
</table>
Table 3 Serial Hardware Interface Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication Protocol</strong></td>
<td></td>
</tr>
<tr>
<td>Computer interface</td>
<td>Compatible with RS232 Protocol</td>
</tr>
<tr>
<td>Field device interface</td>
<td>Compatible with 5Vdc level or 3Vdc level</td>
</tr>
<tr>
<td><strong>Baudrate</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19200 bps, maximum</td>
</tr>
<tr>
<td></td>
<td>9600 bps, typical</td>
</tr>
<tr>
<td><strong>Temperature Range</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>0°C to +50°C (32°F to +122°F), ambient</td>
</tr>
<tr>
<td>Storage</td>
<td>-40°C to +85°C (-40°F to +185°F), ambient</td>
</tr>
<tr>
<td><strong>Operating Humidity Range (RH)</strong></td>
<td>10-90%, noncondensing</td>
</tr>
<tr>
<td><strong>Electrical Isolation</strong></td>
<td>250 Vac</td>
</tr>
<tr>
<td><strong>Cable length</strong></td>
<td></td>
</tr>
<tr>
<td>Computer interface (RS232)</td>
<td>10 meters, maximum</td>
</tr>
<tr>
<td>Field device interface</td>
<td>3 meters, maximum</td>
</tr>
<tr>
<td><strong>Weight (Interface module + cable)</strong></td>
<td>0.5 lbs., maximum</td>
</tr>
<tr>
<td><strong>Approval Bodies</strong></td>
<td>Mark CE</td>
</tr>
</tbody>
</table>
3— Software Installation

SCT 3000 Installation

Installation of the SCT 3000 is broken down into two separate procedures:

1. Software installation
2. Hardware assembly and installation, (described in Section 4).

Note: Install the software first, before the hardware.

SCT 3000 Software Application and Setup

The SCT 3000 software application and Installation Utility are available on a CD ROM. Follow the procedure in this section to install the software.

Running the installation utility

The SCT 3000 software application is installed on your computer using the installation utility. The utility creates all necessary directories, files, application groups and/or items to run SCT application. The utility also updates the registry and checks for adequate system resources, such as disk space and Windows version number.

The installation utility provides a step-by-step procedure for installing the SCT 3000 application on your computer. You must follow the procedure and the appropriate prompts in the utility to properly install the application. You cannot simply copy the files from the CD to your hard drive.

It is recommended that you close any other applications you have running in Windows as these can greatly increase the time for installing your SCT 3000 application.
CD ROM Installation

Uninstall

Before installing the new version of the software, uninstall any previous versions of the SCT 3000 product.

Windows 98, 2000, XP: Select Start/ Settings /Control Panel/Add or Remove Programs/SCT3000/Remove

Vista and Windows 7: Select Start/Control Panel/Programs/Uninstall a program/SCT3000/Uninstall

Follow the dialog prompts to completely uninstall the product.

Install

NOTE
Make sure that you have “Administrator” before installing the product.

The SCT 3000 CD is designed to automatically start the installation utility when you insert it in your computer's CD drive. On-screen prompts should guide you through the install program. Follow the procedure in Table 4 to run the installation utility and setup.

Table 4  SCT 3000 Application Installation from CD ROM

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Insert the SCT 3000 CD into the CD-ROM drive.</td>
</tr>
<tr>
<td>2</td>
<td>If the SCT 3000 Installation Utility does not start after several seconds:  &lt;br&gt; • On the desktop of the computer, click on “My Computer”  &lt;br&gt; • Click on the CD drive icon and Run Setup.exe  &lt;br&gt;The SCT 3000 Installation Utility will start.  &lt;br&gt; NOTE 1: Under Vista and Windows 7, when the Installation is launched automatically, it brings up the following dialog.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
</tr>
<tr>
<td>3</td>
<td>Select Run Setup.exe. A &quot;User Account Control&quot; dialog comes up with “Cancel” and “Allow” options: Select “Allow” to proceed with the Installation and “Cancel” to Cancel the installation. NOTE 2: Under Vista if the Installation Utility does not start after several seconds, run the Setup.exe by selecting “My Computer” and CD drive. It will bring up the “User Account Control” dialog with “Cancel” and “Allow” options: Select “Allow” to proceed with the Installation and “Cancel” to Cancel the installation.</td>
</tr>
<tr>
<td>4</td>
<td>The Installation Utility will lead you through installation of the SCT 3000 application software. On-screen prompts allow you to choose options on where you want the SCT application installed.</td>
</tr>
<tr>
<td>5</td>
<td>Follow the on-screen instructions and answer the prompts to install the application software.</td>
</tr>
<tr>
<td>6</td>
<td>Wait for the Setup Complete dialog box to appear.</td>
</tr>
<tr>
<td>7</td>
<td>Remove the CD from the CD-ROM drive. Click “Finish” to exit. You must restart the computer before you can run the SCT 3000 application.</td>
</tr>
<tr>
<td></td>
<td>Go to Section 4 – Hardware Installation to assemble and install the SCT 3000 hardware.</td>
</tr>
</tbody>
</table>

Click "Finish" to exit.

You must restart the computer before you can run the SCT 3000 application.
4— Hardware Installation

SCT Hardware

As part of the SCT 3000 installation, you must assemble the hardware interface components and then connect them to the computer that you will use with the SCT software application. There are two hardware interfaces available for use with the SCT:

1. DE / HART Modem described below
2. Serial hardware interface (for use with STT 150 only) which is described on page 19.

Note: Install the software first, before the hardware.

DE / HART Modem

DE/HART Modem is used to connect and communicate with all Smartline field devices supported by the SCT 3000, except for the STT 150 transmitter. Components are illustrated below.

Option 1: Modem is connected to the PC via DB9 Male to DB9 Female 9C Serial Pass-Through Cable.

Option 2: Modem is connected to the PC via USB to RS 232 converter adapter.

The adapter cable is used to connect the modem to the field device. The SCT is shipped with two adapter cables and an RS-232 pass-through cable. One adapter cable is equipped with easy hooks and the other has alligator clips at the field device end of the cable.

These options are described below.
DE / HART Modem hardware assembly and installation

Note: To use the SCT 3000 on a desktop computer without a RS-232 Serial Port, you must install a USB to RS-232 Converter and driver. You will be able to order this part from Honeywell. Please see your Honeywell sale representative for more information.

Option 1: DE / HART Modem Interface Installation with RS-232 cable

Note: The DE / HART Modem interface is used with the SCT 3000 when communicating with the non-STT 150 transmitters

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Insert the 9-pin D-type connector of the RS-232 cable into an available serial port connector on the computer and secure using the two captive mounting screws. See above figure.</td>
</tr>
<tr>
<td>2</td>
<td>The COM port also must be set in the SCT 3000 application. See Set COM Port on page 21.</td>
</tr>
<tr>
<td>3</td>
<td>Connect the other end of the RS-232 cable to the Modem. See Communication Port and Advanced Settings on page 17.</td>
</tr>
<tr>
<td>4</td>
<td>Go to DE/HART Modem connections to a field device (p. 23) for a procedure on how to connect the assembled SCT 3000 hardware between the computer and the transmitter.</td>
</tr>
</tbody>
</table>
Communication Port and Advanced Settings

In Windows 98, 2000, XP: Select Start / Settings / Control Panel / System / Hardware / Device Manager / Ports (COM & LPT) / Communications Port.

In Vista and Windows 7 select Start/Control Panel/System and Maintenance/System/Device Manager/Ports (COM & LPT) / Communications Port

Right click on Communications Port and select Properties. Select Port Settings.

Make sure the settings are as below..

Select Advanced and make sure that the Use FIFO buffers(…) check box is selected and Receive Buffer and Transmit Buffers are set to High. See following figure.
Option 2: DE / HART Modem Interface Installation with USB to RS 232 Converter

**Note:** The DE / HART Modem interface is used with the SCT 3000 when communicating with the non-STT 150 transmitters.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Install the USB to RS 232 Converter as in the Instruction sheet 34-ST-33-61.</td>
</tr>
<tr>
<td>2</td>
<td>Connect the Detachable Extension cable (part of the USB to RS 232 converter package) to an available USB port on the computer for SCT 3000 use. The COM port also must be set in the SCT 3000 application. See Set COM Port on page 21.</td>
</tr>
<tr>
<td>3</td>
<td>Connect the other end of the extension cable to the Converter</td>
</tr>
<tr>
<td>4</td>
<td>Connect the DB9 connector end of the Converter to the DB9 connector on the Modem.</td>
</tr>
<tr>
<td>5</td>
<td>Securely fasten the stereo phone jack connector end of the Adapter Cable into the terminal on the other end of the Modem.</td>
</tr>
<tr>
<td>6</td>
<td>Go to DE/HART Modem connections to a field device (p. 23) for a procedure on how to connect the assembled SCT 3000 hardware between the computer and the transmitter.</td>
</tr>
</tbody>
</table>
Serial Hardware Interface (for use with STT 150 only)

A serial hardware interface is available to use with the SCT 3000 when communicating with the STT 150 Smart Temperature Transmitter. The interface consists of the following components:

- **Serial Interface Module** which is an RS-232 standard hardware interface (9-pin D-type connector) that provides the physical and electrical interface between the computer and the field device.

- **An Interface cable** connects the serial interface module to the field device. The cable features a 4-pin connector for the interface module connection and a 3-pin connector at the field device end.

**Note:** The serial hardware interface is used with the SCT 3000 when communicating with the STT 150 Smart Temperature Transmitter.

See Option 2: USB-to-RS-232 converter for USB Option
**Option 1: Interface cable**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Ensure that the power to the computer (PC) is off.</td>
</tr>
<tr>
<td>2</td>
<td>Insert the 9-pin D-type connector of the serial interface module into an available serial port connector on the computer and secure using the two captive mounting screws. See figure below.</td>
</tr>
<tr>
<td>3</td>
<td>Insert the interface cable end (4-pin) into the 4-pin connector on the serial interface module.</td>
</tr>
<tr>
<td>4</td>
<td>Go to Serial Hardware Interface connections to the STT150 for a procedure on how to connect the assembled SCT 3000 hardware between the computer and the STT150 transmitter.</td>
</tr>
</tbody>
</table>

**Note:** Connect the interface module to an available serial port (COM 1 or 2) on the computer for SCT 3000 use. The COM port also must be set in the SCT 3000 application. See Set COM Port on page 21.
Option 2: USB-to-RS-232 converter

There is also USB 2.0 to RS-232 Converter option available for computers that do not have a RS-232 Serial Port. After installing it you must install the driver.

**Step | Action**
---|---
1 | Install the USB to RS 232 Converter as in the Instruction sheet 34-ST-33-61.
2 | Connect the Detachable Extension cable (that is part of the USB to RS 232 Converter package) to an available USB port on the computer for SCT 3000 use. The COM port also must be set in the SCT 3000 application. See Set COM Port on page 21.
3 | Connect the other end of the extension cable to the Converter.
4 | Connect the DB9 connector end of the Converter to the DB9 connector on the Modem.
5 | Securely fasten the stereo phone jack connector end of the Adapter Cable into the terminal on the other end of the Modem.
6 | Go to Serial Hardware Interface connections to the STT150 for a procedure on how to connect the assembled SCT 3000 hardware between the computer and the transmitter.

**Set COM Port (DE / HART Modem Interface or Serial Hardware Interface)**

In the View menu:

Select Options... and then select the General tab.

At the bottom of the tab is the Serial Port box.

Select the name of the serial port that the computer is using for SCT communications (default COM 1). You can type in a name if none of the choices match the name of the computer serial port.

Click OK to make selection and close the Options window.
5— Start up and Working Online

SCT 3000 Application

The SCT 3000 application is an easy-to-use graphical user interface that is similar in functionality to any other Windows-based application. Start up procedures consist of connecting the SCT hardware to a field device and establishing online communications with the device. Also this section describes the SCT 3000 application window, its various components, and how to access the menus and commands to gain more insight into the SCT features.

Getting Online Quickly

The following procedures tell you how to:

- Connect the SCT 3000 hardware to a field device.
- Make an online connection to communicate with a field device.
- Perform online tasks, such as view device parameters, check device status and perform online configuration or device calibration.

Connecting to a field device

---

**WARNING**

The SCT 3000 is not certified for use in hazardous locations.

---

**ATTENTION**

The SCT 3000 can be connected to only one Smart field device at a time.

---

Perform the procedure in Table 5 to connect the assembled SCT 3000 hardware between the computer and the Smartline field device.
### Table 5 DE/HART Modem connections to a field device

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The SCT hardware must be assembled and installed according to the procedures in DE/HART Modem hardware assembly and installation on page 16.</td>
</tr>
</tbody>
</table>
| 2    | Connect the easy hooks or alligator clips on the end of the adapter cable to the respective terminals on the Smart field device or field terminals as shown below:  
  
  -- connect the **red lead** to the **positive terminal**.  
  
  -- connect the **black lead** to the **negative terminal**. |
| 3    | Go to Starting the SCT 3000 application on page 25. |

**RS-232 option**

![RS-232 option diagram]

**USB-to-RS-232 option**

![USB-to-RS-232 option diagram]

**Note:** The DE/HART modem must be connected to a powered loop with at least 250 ohms of resistance.
## Serial Hardware Interface connections to the STT150

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The SCT hardware must be assembled and installed. See Serial Hardware Interface (for use with STT 150 only) on page 19.</td>
</tr>
<tr>
<td>2</td>
<td>Plug the 3-pin connector of the interface cable into the connector on the STT150 transmitter.</td>
</tr>
<tr>
<td>3</td>
<td>Go to Starting the SCT 3000 application on page 25.</td>
</tr>
</tbody>
</table>

Note: With the USB to RS 232 Options, the assembled hardware connects to the USB Port.

**Note:** The Serial Hardware interface must be connected to a powered loop with at least 250 ohms of resistance.

**ATTENTION**

Do not disconnect the serial interface module from the computer while running the SCT3000 program.
Starting the SCT 3000 application

The steps in Table 6 tell you how to start the SCT 3000 application and establish online communications with the connected field device.

**Table 6 Starting the SCT 3000 Application**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power up the computer and allow the PC to start up.</td>
</tr>
</tbody>
</table>
| 2    | In Windows 98, 2000 or XP:  
Click the “Start” button.  
Select:  
"Programs",  
"Smartline Configuration Toolkit",  
"SCT 3000" to start the SCT 3000 application. See figure. |

In Vista Ultimate and Vista Business and Windows 7: Click the Start button.  
Select All Programs\Smartline Configuration Toolkit\SCT3000

**Note:**

- Alternately, you can click the SCT 3000 icon from the computer desktop to start the SCT 3000 application.
- The SCT 3000 main application window also offers the following file:
  
  SCT 3000 Help File – make this selection to access the SCT 3000 help system; refer to Online Help Features in Section 7 for a complete description of the online help system.
### Step 3

When the SCT 3000 Banner Window appears (see Figure 2), type in your designated user name in the name entry field. Note that you must enter a user name that is at least three (3) alphanumeric characters long. Any spaces before or after the user name string will be dropped off when the Banner Screen appears.

Click the “Cancel” button at any time to exit out of the SCT 3000 banner window and application.

Click the “Help” button at any time to access the SCT 3000 Help system.

### Step 4

Click **OK** to access the SCT 3000 application. The SCT 3000 application window (see Figure 3) immediately appears on the screen.

**Figure 2 SCT 3000 Banner Window**
<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 5    | Check the status bar at the bottom right of the application window. **SERIALOK** should appear to indicate that the SCT 3000 detects the SCT hardware and a connected field device. This is the online status of the SCT 3000.  
If not, a loose hardware connection or possible communications problem may exist. See Section 8, *Troubleshooting* |
| 6    | In the **Device** menu:  
Select “**Upload**” (or click on the Upload toolbar button) to upload the current database configuration from the connected device and make the online connection.  
- A Communications Status dialog box displays during the uploading process. |
| 7    | When upload is complete, the online view of the connected field device appears on the screen. The window shows a number of tabs which contain various parameters that make up the device’s configuration database.  
Access the Status tab by clicking on its tab. The Status tab is used to verify the status of the connected field device.  
- Separate boxes for Gross Status and Detailed Status messages are presented in the Status tab. Refer to the SCT 3000 online User Manual for explanations of each status condition. |
| 8    | Click on the various tabs in the application window to view configuration parameters and device status. |

**Note:** See Section 6 – *Working Offline* for procedures to create new database files.

**TIP**

Once you have started the SCT 3000 application, you can access the online help topics and context-sensitive help that describe all features in the application window. See *Online Help Features* in Section 7. Also there is the online user manual that provides extensive information on how perform all offline and online tasks.
SCT 3000 Features

SCT application window

The SCT 3000 application window (see Figure 3) is the main window that appears when starting up the SCT 3000 application. This window allows access to all available SCT 3000 menus and commands.

Figure 3  SCT 3000 Application Window

The functional elements in the SCT 3000 application window that are unique to the application are briefly explained here.

- **Control icon** displays the SCT icon at the left corner of the application window.
- **Menu bar** contains headings so you can access individual groups of drop-down menus and commands that are selectively available in the application.
- **Toolbar** appears across the top of the application window below the menu bar, when selected for display. The toolbar features a number of icons that provide quick mouse access to many commands used in the SCT 3000. To display (or hide) the toolbar, use the Toolbar command in the View menu.
• **Status bar** appears at the bottom of the SCT 3000 application window, when selected for display. The status bar tells you to press F1 key to access the online help and also displays the status of the online connection to the field device. To display (or hide) the status bar, use the Status Bar command in the View menu. See Section 8 for more information on status bar messages.

• **Standard application window features** - We assume you are already familiar with the concepts of the title bar, maximize, minimize and close buttons and scroll bars. If not, refer to the appropriate Windows manual for descriptions of each element.

**Toolbar icons**

The toolbar in the SCT application window contains a row of icons (shown below) that select commands frequently used when operating with the SCT. By moving the cursor over the icon, the name of the command is displayed. You can also use the context-sensitive feature to display the help topic about each icon.

![Toolbar icons](image)

**Online vs. Offline**

Working online with the SCT 3000 entails communicating with a field device that is connected to the computer via one of the hardware interfaces.

![Online Operation Setup](image)
Working online

Working online allows you to:

- Download a database file to the connected field device during installation or commissioning of your process application.
- Upload database from the connected field device to verify device configuration and make changes, if necessary.
- Monitor device output and status with the data and status being periodically refreshed. The PV Monitor display window graphically shows you values of input PVs, output PVs and SVs of the connected device in real time. View device status messages for detection, diagnosis and troubleshooting of possible fault conditions.
- Perform field calibration on the connected device.
- Change communications mode of the field device (analog mode or DE)

Working offline

Working offline means that you are using the SCT 3000 application without being connected to a field device. Working offline allows you to:

- Perform database management of database files. This entails creating or changing device configuration database files, saving the files to disk for downloading at a later time.
- Compare one database file with another. See Section 6 for more details.
- Print database files. See Section 6 for more details.
6— Working Offline - Using the SCT 3000 Offline

Using the SCT 3000 Offline

Working offline with the SCT 3000 means that you are using the SCT application without being connected to a field device. You can work at a location away from the field network. Working offline allows you to manage Smartline field device database files.

Database file management

You can create, copy, transfer and change configuration database files for supported field devices.

To create a new database file:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | In the File menu,  
Select New, (or click on the “New” icon on the toolbar).  
The Add New Template dialog appears. |
| 2    | Click on one of the three tabs to display a list of available templates for supported field devices.  
- Honeywell Templates lists preconfigured templates for various models of Honeywell field devices. Use the Device Filter box to select templates for a particular device type.  
- User Templates shows a list of previously saved database file templates.  
- A Generic Template can be used to view and modify a device’s extended parameter data. |
| 3    | Select a template name and click OK.  
The configuration tabs for the device type appear on the screen. |
| 4    | Now you can enter and change the parameters on the tabs for a specific device in a process application. |
| 5    | Click the “Save” icon on the toolbar and enter a unique filename for the device database file. |
To open an existing database file:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the File menu, Select Open (or click on the “Open” icon on the toolbar). The Open dialog will appear to show the existing database files (.sct) in the Templates folder.</td>
</tr>
<tr>
<td>2</td>
<td>Double click on a file name to open it. The configuration tabs for the device type appear on the screen.</td>
</tr>
<tr>
<td>3</td>
<td>Now you can enter and change the parameters on the tabs for a specific device.</td>
</tr>
<tr>
<td>4</td>
<td>Click the “Save” icon on the toolbar to save changes to the database file.</td>
</tr>
</tbody>
</table>

Parameter checking

When entering configuration parameters in a database file, the SCT 3000 automatically verifies and validates each selected parameter relationship with other parameters associated with the given field device. If entry of one parameter results in other parameters becoming invalid, the SCT automatically disallows entry of the invalid parameter. This ensures that the configuration can be downloaded to the field device without any resulting errors.

Printing a database document

The SCT 3000 actively maintains a printable document that provides summary information for the configuration (and Wizard) database associated with each Smart field device. Each document lists the individual parameters and associated values for each device’s configuration database.

To print a database file:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The database file must open and the configuration window must be active.</td>
</tr>
<tr>
<td>2</td>
<td>Click on the “Print” icon on the toolbar. The Print dialog appears. If necessary, select printer, page numbers and number of copies.</td>
</tr>
<tr>
<td>3</td>
<td>Click “OK”</td>
</tr>
</tbody>
</table>

Database Compare function

A Database Compare function in the SCT 3000 allows you to compare either two configuration windows for differences or the active configuration window and a designated configuration file.

To compare the database files of two configuration windows for differences:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Device menu, Select Compare To… &gt; Window….</td>
</tr>
</tbody>
</table>
To compare the database file of the current configuration window to another database file:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the Device menu, Select Compare To… &gt; File…. The Open dialog will appear to show the existing database files (.sct) in the Templates folder.</td>
</tr>
<tr>
<td>2</td>
<td>Double click on a filename to open the database file and compare it to the active configuration window database.</td>
</tr>
<tr>
<td>3</td>
<td>A Compare Results window shows the differences between the two database files.</td>
</tr>
</tbody>
</table>

Compare Results

The Compare Results window shows a list of all parameters that are contained in both the current window and the designated window or database file but which contain different configuration values. Note that when an attempt to compare database files for two dissimilar devices, (for example an ST 3000 and an SMV 3000), the Compare Results will list only the Transmitter Type in the results window.
7— Online Help

Online Help Features

Online help features allow easy access to information for using the SCT 3000 application. Three types of help are built-in to the SCT.

1. **Online Help Topics** — SCT 3000 Help topics can be accessed through a Table of Contents or by using the Index and Find function. These functions enable you to locate information about specific topics while in any SCT window.

2. **Context-sensitive Help** — A help topic can be displayed on a particular item you select simply by requesting help and selecting the item.

3. **Online User Manual** — An online document that provides extensive information on how to configure, calibrate, diagnose and monitor the field devices supported by the SCT 3000.

Accessing help

Help topics can be accessed a number of ways. From the Help pull down menu, which is accessible from the SCT 3000 menu bar, choose a help category (see Table 7).

- Press F1 while focused on a particular window, entry or selection field, menu item or dialog box option.
- Choose the Help command button that is available in many dialog boxes and configuration forms.
- Click on the context-sensitive help button on the toolbar and then click on any particular item.

---

**TIP**
The Help topics and online user manual provide extensive information about SCT application features and all available online and offline tasks for field device operation.

---

Table 7 lists the Help menu selections available to you along with a description of the help feature.

### Table 7  Help Menu Selections

<table>
<thead>
<tr>
<th>Help Menu Selection</th>
<th>Help Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tip of the Day ...</strong></td>
<td>Displays help tips about using the SCT 3000 Smartline Configuration Toolkit.</td>
</tr>
<tr>
<td><strong>Help Topics</strong></td>
<td>Opens a window so you can access the SCT 3000 Help topics by using Help’s Table of Contents or by selecting an Index or</td>
</tr>
<tr>
<td>Help Menu Selection</td>
<td>Help Feature</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Find search function.</td>
<td></td>
</tr>
<tr>
<td>STT150 Operator Manual</td>
<td>Opens a copy of the STT150 Temperature transmitter operator manual. This selection is available only if you are connected to a STT150 transmitter.</td>
</tr>
<tr>
<td>User Manual</td>
<td>Opens the SCT 3000 online user manual, which lists the various sections of information available within the manual.</td>
</tr>
</tbody>
</table>
8—Some Vista and Windows 7 Tips and Notes:

**TIP 1:** Standard Users can open the files in Root drives (C:\, D:\ etc) or Program Files and its subfolders or Windows folders and its subfolders with Read Only access. They do not have Write permissions on these locations. Administrators have both Read / Write Access to these locations.

**Some Popup dialogs and explanation:**

**Dialog 1:**

![Popup Dialog Example](image)

This dialog will be displayed in two situations:

- when the user selects File\Save (or selects File Save icon on the Toolbar) to save the file from within the SCT 3000 application to any of the folders below:
  - Root Drive (C:\, D:\ etc)
  - <Drive>:\ Program Files\ or <Drive>:\Program Files\Some Folder\...
  - <Drive>:\Windows\ or <Drive>:\Windows\Some Folder\...

- when the user selects File\Export command to export the current configuration to a file from within the SCT 3000 application to any of the folders below:
  - Root Drive (C:\, D:\ etc)
  - <Drive>:\ Program Files\ or <Drive>:\Program Files\Some Folder\...
  - <Drive>:\Windows\ or <Drive>:\Windows\Some Folder\...

This simply means that the Standard Users have limited access to these location and the user should save the file to a different location. Preferred location is the Users Public Folder which is located at <Drive>:\Users\Public\Public Documents\...
Dialog 2:

![Save As Dialog]

This dialog will be displayed when the user selects File\Save As to save the file with a new name, from within the SCT 3000 application to any of the folders below:

- Root Drive (C:\, D:\ etc)
- <Drive>:\ Program Files\ or <Drive>:\Program Files\Some Folder\...
- <Drive>:\Windows\ or <Drive>:\Windows\Some Folder\...

This automatically redirects File Save to <Drive>\Users\StandardUser folder and you can save to this location. OR you can save to any folder other than the restricted locations listed above.

**TIP 2:** When switching between Admin and Standard User, always, always Exit the SCT 3000 application to release all the resources (COM port, process HANDLEs etc). If not, the COM port will not be available to the second user and vice versa.

**TIP 3:** On Installation, the following message indicates you are not an Admin. Only Administrators can install the SCT 3000 Installation setup.

![SCT 3000 Error Message]

**TIP 4:** On launching the SCT3000 application (by selecting Start\All Programs\Smartline Configuration Toolkit\SCT3000), you get the "User Account Control" dialog, similar to the dialog in Fig a or b. In case of Figure a type dialog, select "Allow" to proceed, "Cancel" to Cancel. In case of Figure b type dialog, select "Continue" to proceed and "Cancel" to Cancel. This is a Vista feature that helps stop unauthorized changes to your computer.
Figure a

Figure b
9— Troubleshooting

Overview

If trouble arises, it may happen during installation of the SCT 3000 application or during normal operation. Due to differences in computer systems, problems are not always predictable. However this section seeks to provide some suggestions on possible remedies to problems that may occur during installation or operation of the SCT 3000 application.

First this section provides troubleshooting suggestions to help clear up problems. Next, is a listing of all the error codes and communication status messages that are generated by the SCT 3000 application. Last, information and phone contacts to reach Honeywell Technical Assistance are provided if the information in this manual or in the SCT application does not address or remedy a problem.
Troubleshooting SCT Application and the hardware

Please note the following consideration when encountering problems with the SCT 3000 application installation:

- You can install the SCT 3000 application software on a computer that does not have serial ports. The SCT 3000 will run correctly on these computers but you may only be able to operate in the offline mode.

If you are encountering problems while running the SCT 3000 Software, use the troubleshooting Table 8 to find the symptom and refer to the action to correct the trouble.

**Table 8  SCT 3000 Installation Troubleshooting Table**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to complete setup procedure for SCT 3000 application installation.</td>
<td>Insufficient disk free space on computer.</td>
<td>Check to make sure that there is enough free disk space on the computer's fixed disk to allow installation of the SCT 3000 application and its associated files. The system requirements for application size are listed in Table 1.</td>
</tr>
<tr>
<td>Unable to run setup and installation utility for SCT 3000 application.</td>
<td>You do not have write (Admin) privileges in the directories specified for the installation.</td>
<td>See your system administrator.</td>
</tr>
</tbody>
</table>

Troubleshooting SCT 3000 Operation

To avoid problems that may occur during initial start-up of the SCT 3000 application, note the following consideration:

Install the SCT 3000 Smartline Configuration Toolkit application software on the computer before making modem connections.

The troubleshooting table below describes conditions that may occur when running the SCT 3000 application. Please note the probable causes and things to do in order to correct the condition.

**Symptom**

**Probable Cause**

**Corrective Action**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to establish online connection with field device.</td>
<td>Loose hardware connection between computer and field device.</td>
<td>Check all hardware connections.</td>
</tr>
<tr>
<td><strong>Status bar message:</strong> NO SERIAL or COM UNKNOWN</td>
<td><em>If you are using the DE/HART modem Option:</em></td>
<td></td>
</tr>
<tr>
<td>a) Hardware components are not properly assembled.</td>
<td>a) See DE / HART Modem hardware assembly and installation on page 16 for procedure.</td>
<td></td>
</tr>
<tr>
<td>Symptom</td>
<td>Probable Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>b) DE/HART modem is not the current version.</td>
<td>b) Check Modem firmware version. In the Help menu, select About Modem. Obtain Modem version 1.0 or greater.</td>
<td></td>
</tr>
<tr>
<td>c) The DE/HART mode is not properly installed.</td>
<td>c) See DE / HART Modem hardware assembly and installation on page 16.</td>
<td></td>
</tr>
<tr>
<td>d) Hardware is not properly connected between the computer and the Smart field device.</td>
<td>d) See DE/HART Modem connections to a field device (p. 23) for procedure.</td>
<td></td>
</tr>
<tr>
<td>e) Serial port not selected.</td>
<td>e) Make sure that the serial port on the computer is available for use with the serial hardware interface. In the View menu, select Options… Click the General tab. Select a Serial port name that corresponds to the serial port on the computer. (If the computer port names are different, then type the computer’s Serial port name into the edit box on the General tab.)</td>
<td></td>
</tr>
<tr>
<td>f) Serial port being used by another application or device. (Other software applications running on the computer may use the serial port, thus making it “unavailable” for SCT 3000 communications.)</td>
<td>f) same as e)</td>
<td></td>
</tr>
<tr>
<td>g) Serial port settings are incorrect</td>
<td>g) Make sure the port settings are set. See Communication Port and Advanced Settings on page 17.</td>
<td></td>
</tr>
<tr>
<td>h) Modem Battery is Low</td>
<td>h) Replace the Modem Battery. See Modem Maintenance on page 52.</td>
<td></td>
</tr>
</tbody>
</table>
## Troubleshooting - Troubleshooting SCT 3000 Operation

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Probable Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to establish online connection with field device.</td>
<td>If you are using the serial hardware interface:</td>
<td>a) See Serial Hardware Interface connections to the STT150 on page 24.</td>
</tr>
<tr>
<td></td>
<td>a) Hardware components are not properly connected.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b) Serial port not selected.</td>
<td>b) and c) Make sure that the serial port on the computer is available for use with the serial hardware interface.</td>
</tr>
<tr>
<td></td>
<td>OR -</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c) Serial port being used by another application or device.</td>
<td>In the View menu, select Options…</td>
</tr>
<tr>
<td></td>
<td>(Other software applications running on the computer may use the serial port, thus making it “unavailable” for SCT 3000 communications.)</td>
<td>Click the General tab. Select a Serial port name that corresponds to the serial port on the computer. (If the computer port names are different, then type the computer’s Serial port name into the edit box on the General tab.)</td>
</tr>
<tr>
<td>Status bar message: NO SERIAL or COM UNKNOWN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communication errors when trying to connect online to a field device.</td>
<td>a) Loose hardware connection between computer and field device.</td>
<td>a) Check all hardware connections.</td>
</tr>
<tr>
<td></td>
<td>b) You are trying to communicate with a field device that is not supported by the current version of the SCT 3000.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b) None.</td>
<td>Refer to the Readme.txt file supplied with the SCT 3000 application for the latest list of Honeywell-supported Smart field devices.</td>
</tr>
<tr>
<td>Unable to see Input or Output Calibration tabs when in online mode.</td>
<td>Calibration not enabled in Options… dialog box.</td>
<td>In the View menu, Select Options…</td>
</tr>
<tr>
<td></td>
<td>Note: Calibration tabs are not visible when operating in the offline mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The computer that is running the SCT 3000 application must be connected to a field device to perform calibration. SCT 3000 software is designed to detect an online connection before it displays the Input Calibration and Output Calibration tabs.</td>
<td></td>
</tr>
<tr>
<td>FlowAlg, Flow Setup, and Equation tabs are not visible in the SMV 3000 configuration window.</td>
<td>Expert Configuration not enabled in Options… dialog box</td>
<td>In the View menu, Select Options… Click the General tab. Check the Enable Expert Configuration in the Customize Options box.</td>
</tr>
</tbody>
</table>
9— Troubleshooting - SCT Error Codes

### Table 9

<table>
<thead>
<tr>
<th>Error Number</th>
<th>Error Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>General</td>
<td>The transaction failed due to a request that was not valid for the current device configuration.</td>
</tr>
<tr>
<td>101</td>
<td>Invalid Parameter</td>
<td>The selected database item (parameter) could not be accessed because it is not valid for the current configuration.</td>
</tr>
<tr>
<td>102</td>
<td>Operation Pending</td>
<td>The transaction failed because another transaction is currently pending.</td>
</tr>
<tr>
<td>103</td>
<td>Out of Range</td>
<td>The entered value is not within the valid range.</td>
</tr>
<tr>
<td>104</td>
<td>Invalid Value</td>
<td>The entered value is not a valid floating point number. The acceptable floating point format is (+MANTISSA+EXPONENT). For example &gt; 6, -1.2, 34.5e-4, 6e8.</td>
</tr>
<tr>
<td>Error Number</td>
<td>Error</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>105</td>
<td>No Response</td>
<td>The attached Smart device did not respond. Make sure that the physical connection is secure.</td>
</tr>
<tr>
<td>106</td>
<td>Invalid Response</td>
<td>The attached Smart device did not respond properly since the response was not recognizable. The message was probably corrupted by external influences.</td>
</tr>
<tr>
<td>107</td>
<td>Illegal operation</td>
<td>The requested transaction is not supported by the attached Smart device. Make sure that the device version is compatible with the current release of the SCT 3000. See the ReadMe.txt file supplied with the SCT 3000.</td>
</tr>
<tr>
<td>108</td>
<td>Local Mode</td>
<td>The attached Smart device could not process the request because it has been placed in local mode. No more transactions can be processed until local mode is disabled.</td>
</tr>
<tr>
<td>109</td>
<td>Transmitter Busy</td>
<td>The transaction failed because the attached Smart device is too heavily loaded and is unable to process communication requests.</td>
</tr>
<tr>
<td>110</td>
<td>Write Protected</td>
<td>The value could not be written because the attached Smart device is write protected. The hardware jumper within the device must be repositioned in order to permit write operations. The STT250 contains a write protection feature that uses a password key in the transmitter configuration.</td>
</tr>
<tr>
<td>111</td>
<td>Unable to Format Message</td>
<td>Some or all of the information required to format the desired communications message is not available. Make sure that all database items on the configuration tab cards have valid values.</td>
</tr>
<tr>
<td>112</td>
<td>Data Inaccessible</td>
<td>The requested data is inaccessible or not available.</td>
</tr>
<tr>
<td>113</td>
<td>Card Not Available</td>
<td>The DE PC card is not present or not functional. Make sure that the card is completely inserted in the PCMCIA slot and that the appropriate drivers have been installed.</td>
</tr>
<tr>
<td>114</td>
<td>Communications Channel Not Available</td>
<td>The communications channel is temporarily unavailable.</td>
</tr>
<tr>
<td>115</td>
<td>No Message Pending</td>
<td>A message response is expected but none is available.</td>
</tr>
<tr>
<td>116</td>
<td>Communications Type Unknown</td>
<td>The transaction failed because the type of communications (analog or DE) could not be determined</td>
</tr>
<tr>
<td>117</td>
<td>Communications Timeout</td>
<td>The transaction failed due to an internal timeout. The error is usually indicative of a condition that will require restarting the host computer.</td>
</tr>
<tr>
<td>118</td>
<td>Parameter Not Ready</td>
<td>Data from the requested database item has not yet been uploaded from the attached Smart device.</td>
</tr>
<tr>
<td>119</td>
<td>Parameter Unknown</td>
<td>The database item is valid based upon the current configuration, but its value is unknown (as indicated by a series of question marks -- ????).</td>
</tr>
<tr>
<td>Error Number</td>
<td>Error</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>120</td>
<td>Download Failed</td>
<td>The download operation failed due to a problem with the current configuration or a communications error.</td>
</tr>
<tr>
<td>121</td>
<td>Serial Port is not available</td>
<td>The serial port is not available or is not functional. Loose hardware connection. Make sure that the physical connection is secure.</td>
</tr>
</tbody>
</table>
Status Bar

The status bar appears at the bottom of the SCT 3000 application window. To display (or hide) the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. This area similarly shows messages that describe the actions of the toolbar buttons as you depress them, before releasing them. If after viewing the description of the menu item or toolbar button command you wish not to execute the command, then release the mouse button while the pointer is off the menu item or toolbar button.

The status bar also displays additional information in two of the four boxes on the right side of the bar. The last two boxes contain status of the communications link between the computer and the field device. See the following figure and table.
messages that are displayed in boxes A, B and C.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Box A – Indicates the status of hardware interface.</td>
<td></td>
</tr>
<tr>
<td>SERIALOK</td>
<td>Serial interface hardware detected and is communicating</td>
</tr>
<tr>
<td>NO SERIAL</td>
<td>No serial interface detected</td>
</tr>
<tr>
<td>SERIAL BAD</td>
<td>Serial interface fault</td>
</tr>
<tr>
<td>Box B – Indicates the selected communications mode.</td>
<td></td>
</tr>
<tr>
<td>ANALOG</td>
<td>Device is communicating in the analog mode.</td>
</tr>
<tr>
<td>DE4BYTE</td>
<td>Device is communicating digitally (DE mode) in either a 4 byte or 6 byte format.</td>
</tr>
<tr>
<td>DE6BYTE</td>
<td></td>
</tr>
<tr>
<td>COM UNKNOWN</td>
<td>Indicates that the current view is not online.</td>
</tr>
<tr>
<td>Box C* – Indicates DE/HART modem status.</td>
<td></td>
</tr>
<tr>
<td>Modem :OK</td>
<td>DE / HART modem is functioning normally</td>
</tr>
<tr>
<td>Modem :Unknown</td>
<td>Modem Status is Unknown. Possible reasons:</td>
</tr>
<tr>
<td></td>
<td>No Serial Communication</td>
</tr>
<tr>
<td></td>
<td>Modem is Bad</td>
</tr>
<tr>
<td></td>
<td>Modem Battery is bad</td>
</tr>
<tr>
<td>Modem : Bad</td>
<td>Modem is Bad. Possible reasons:</td>
</tr>
<tr>
<td></td>
<td>Low battery, ROM Failure and ROM Failure</td>
</tr>
<tr>
<td></td>
<td>Low battery and ROM Failure</td>
</tr>
<tr>
<td></td>
<td>Low battery and RAM Failure</td>
</tr>
<tr>
<td></td>
<td>ROM and ROM Failure</td>
</tr>
<tr>
<td></td>
<td>ROM Failure</td>
</tr>
<tr>
<td>Modem : Low Battery</td>
<td>Modem Battery is Low</td>
</tr>
</tbody>
</table>

*DE/HART Modem only
Modem Maintenance

When you are not using the SCT 3000 software, please close the application. As long as the application is running, the modem battery will be used. Modem constantly checks for DE Network state (Analog, DE 4 Byte or 6 Byte), any break in the connections (No Serial, COM UNKNOWN etc.) and Modem Status (Low Battery, ROM Failure, RAM Failure etc).

When to replace battery

The battery should be replaced:

- when one of these messages appears in the Modem Diagnostics display (in the Modem Status box, lower right):
  
  **Low Battery**
  
  **Unknown (after checking wiring connections)**
  
  **ROM Failure**
  
  **RAM Failure**

- in periodic maintenance, when voltmeter test indicates low voltage.
How to replace battery

Before replacing, obtain a new CR-V3p battery. Honeywell recommends Panasonic CR-V3p. Other models may perform adequately but not as well.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Remove the screw that holds the battery cover in place, and remove the cover from the battery compartment.</td>
</tr>
<tr>
<td>2</td>
<td>Press lightly on the bottom of the battery as shown in the picture below, rotating the battery outward at the top. Note the orientation of the battery in the compartment, and then remove it from the case.</td>
</tr>
<tr>
<td>3</td>
<td>Noting orientation of the new battery and the terminals, insert the new battery into the case.</td>
</tr>
<tr>
<td>4</td>
<td>Replace the cover and the retaining screw.</td>
</tr>
</tbody>
</table>

**WARNING !**

Never remove the cover of the battery compartment, or attempt battery replacement in areas designated as having a potentially Explosive atmosphere.
Honeywell’s Technical Assistance Center

Technical support options

Honeywell offers various technical support options to help you get the most from the SCT 3000 application.

ATTENTION
Before contacting Honeywell’s Technical Assistance Center (TAC), first try to resolve any apparent problems by referring to this section, this manual, or the online help system or user manual (if available).

By telephone

You can reach Honeywell’s Technical Assistance Center for technical support by phone during normal business hours.

Honeywell Technical Assistance Center Phone: 1-800-423-9883

You may also seek additional help by contacting the Honeywell distributor who supplied your SCT 3000.

By e-mail

You can also e-mail your technical questions or comments about this product to:

Honeywell Technical Assistance Center e-mail: ace@honeywell.com
Appendix A

For future reference.
ATTENTION
Note that the SCT 3000 application is not compatible with Norton File Assist. The SCT 3000 Setup program is coded to detect the presence of Norton File Assist on the computer and, if present, adds a line to the program to ensure that Norton File Assist does not run with the SCT 3000 application.
## Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Analog (R100/R200) Protocol</strong></td>
<td>The Honeywell-proprietary analog communications protocol for Smartline field instruments as defined by the Smart Field Network (SFN) Specification.</td>
</tr>
<tr>
<td><strong>DE (Digitally Enhanced) Protocol</strong></td>
<td>Honeywell-proprietary digital communications protocol for Smartline field instruments as defined by the Smart Field Network (SFN) Specification.</td>
</tr>
<tr>
<td><strong>Download</strong></td>
<td>Refers to the action of transferring an SCT 3000 configuration database file from the host computer to a connected Smart field device.</td>
</tr>
<tr>
<td><strong>GUI</strong></td>
<td>Graphical User Interface is a term for the graphical images displayed on the computer screens that are generated to simplify the interpretation and selection of data or actions by the computer user.</td>
</tr>
<tr>
<td><strong>PC</strong></td>
<td>Personal Computer</td>
</tr>
<tr>
<td><strong>Smart Field Network (SFN)</strong></td>
<td>Refers to the Honeywell Smart Field Network (SFN) protocol that defines communication mechanisms for Honeywell analog and digital field devices.</td>
</tr>
<tr>
<td><strong>Tag ID</strong></td>
<td>Refers to an ASCII field used to uniquely identify a field device at a specific customer location</td>
</tr>
<tr>
<td><strong>Upload</strong></td>
<td>Refers to the action of transferring the field device’s data to an SCT 3000 configuration database window.</td>
</tr>
</tbody>
</table>
Index

A
Application window, 28

C
CD ROM drive, 5
CD ROM Installation, 12
Computer specifications, 5
Connecting to a field device, 22

D
Database compare function, 34
Database file
   Existing, 34
   New, 33
Database file management, 33
Display specification, 5

F
Field devices supported, 2
Flow Wizard, 3

G
Glossary, 57

H
Hardware installation, 15
Hardware specifications
   Serial hardware interface, 7
   Smartline Option Module, 7
   Hazardous locations, 7, 22
Help
   Accessing, 37
   Help menu, 37

I
Installation utility, 11
Interface cable. See also Serial hardware interface

M
Maximize and minimize buttons, 28
Menu bar, 28

O
Offline mode, 3
Online help features, 37
Online mode, 3
Operating systems, 3, 5

P
Parameter checking, 34
Pointing device, 5
Ports (I/O for printer and serial hardware interface), 5
Power source, 5
Printing a database document, 34
PV Monitoring, 3
RAM requirements, 5

S
SCT 3000
   Compatible computers, 6
   Connections to a field device, 22
   Error codes, 47
   Hardware, 7
   Installation utility, 11
   PC specifications, 5
   Software compatibility, 6
   Toolkit contents, 1
SCT 3000 application installation
   CD ROM, 12
SCT 3000 application program, 22
SCT 3000 banner window, 26
SCT 3000 software features, 3, 28
Serial hardware interface, 7
   Assembly and installation, 19
   Description, 19
Smartline Configuration Toolkit, SCT 3000
   Description, 1
Software installation, 11
Solution Support Center, 54
Starting the SCT 3000 application, 25
Status bar, 29
Status bar messages, 50
T

Technical support options, 54
Toolbar, 28, 29
Troubleshooting, 39, 43
   Error codes, 47
   SCT 3000 operation, 44
   Troubleshooting tables, 44

W

Working offline, 30, 33
Working online, 22, 30
Sales and Service
For application assistance, current specifications, pricing, or name of the nearest Authorized Distributor, contact one of the offices below.

**ASIA PACIFIC**

**Control Products**
Asia Pacific Headquarters
Phone: +(65) 6355-2828
Fax: +(65) 6445-3033

**Asia Pacific Technical Support**
Field Instruments
Phone: +65 6560 3156
Fax: +65 6445-3033
Process Instruments
Phone: (603) 7956 8922
Fax: (603) 7956 8922

**Honeywell Inc.**

**Japan**
Phone: +(91) 5603-9400
Fax: +(62) 21-5367 1008

**India Automation India Ltd.**
Honeywell Ltd.
Phone: +(91) 5603-9400
Fax: +(91) 5603-9600

**Japan**
Honeywell Inc.
Phone: +(81) 3 6730 7150
Fax: +(81) 3 6730 7228

**Malaysia**
Honeywell Engineering Sdn Bhd
Phone: +(60-3) 7950-4776
Fax: +(60-3) 7958-8922

**New Zealand**
Honeywell Limited
Phone: +(64-9) 623-5052
Fax: +(64-9) 623-5060
Toll Free (0800) 202-088

**Philippines**
Honeywell Systems (Philippines) Inc.
Phone: +(63-2) 633-2830-31/636 1661-62
Fax: +(63-2) 638-4013

**South Korea**
Honeywell Korea Co Ltd
Phone: +(822) 799 6315
Fax: +(822) 792 9015

**Thailand**
Honeywell Systems (Thailand) Ltd.
Phone: +(662) 693-3099
Fax: +(662) 693-3099

**Taiwan R.O.C.**
Honeywell Taiwan Ltd.
Phone: +(886-2) 2245-1000
Fax: +(886-2) 2245-3241

**SE Asia Countries**
see Honeywell Pte Ltd (Singapore)
for: Pakistan, Cambodia, Guam, Laos, Myanmar, Vietnam, East Timor

**SE Asia Countries**
see Honeywell Automation India Ltd for:
Bangladesh, Nepal, Sri Lanka

**EUROPE**

**Austria**
Honeywell Austria GmbH
Phone: +(316) 4001123
Fax: +(316) 400117

**Belgium**
Honeywell SAVV
Phone: +32 (0) 2 728 24 07
Fax: +32 (0) 2 728 22 45

**Bulgaria**
Honeywell EOOD
Phone: +(359) 2 40 20 900
Fax: +(359) 2 40 20 900

**Czech Republic**
Honeywell spol. s.r.o.
Phone: +420 242 442 232
Fax: +420 242 442 131

**Denmark**
Honeywell A/S
Phone: +(45) 39 55 55 55
Fax: +(45) 39 55 55 58

**Finland**
Honeywell OY
Phone: +(358) 020752 2753
Fax: +(358) 020752 2751

**France**
Honeywell SA
Phone: +(33) (01) 60 180 075
Fax: +(33) (01) 60 180 210

**Germany**
Honeywell AG
Phone: +(49) 690864-239
Fax: +(49) 69084797336

**Holland**
Honeywell B.V.
Phone: +(31) (0) 20 5656200
Fax: +(31) (0) 20 5656210

**Italy**
Honeywell S.p.A.
Phone: +390292146307
Fax: +39 0292146377

**The Netherlands**
Honeywell B.V.
Phone: +(31) (0) 20 5656200
Fax: +(31) (0) 20 5656210

**Norway**
Honeywell A/S
Phone: (45) 39 55 55 55

**Poland**
Honeywell Sp. zo.o
Phone: +48-22-6090900
Fax: +48-22-6090901

**Portugal**
Honeywell Portugal Lda
Phone: +(351) 21 424 5000
Fax: +(351) 21 424 50 99

**Romania**
Honeywell Bucharest
Phone: +(40) (21) 2316437
Fax: +(40) (21) 2316439

**Russia**
Regional Federation (RF),
ZAO "Russian Honeywell"
Phone: +(7) (495) 796 98 00
Fax: +(7) (495) 797 99 64

**Slovak Republic**
Honeywell s.r.o.
Phone: +(421-2) 58247 410
Fax: +(421-2) 58247 415

**Spain**
Honeywell S.A.
Phone: +(34) (91) 131 61 00
Fax: +(34) (91) 131 61 30

**Sweden**
Honeywell AB
Phone: +(46) 8 775 55 00
Fax: +(46) 8 775 56 00

**Switzerland**
Honeywell AG
Phone: +41 18552448
Fax: +(41) 1 855 24 45

**Turkey**
Honeywell Turkey A.S.
Phone: +90 216 578 71 00
Fax: +90 216 575 66 35

**United Kingdom**
Honeywell Control Systems Ltd.
Phone: +(44) (01) 344 655251
Fax: +(44) (01) 344 655554

**AFRICA**

**Mediterrean & African Distributors**
Honeywell SpA
Phone: +39 (02) 250 10 604
Fax: +30 (02) 250 10 659

South Africa (Republic of)
Honeywell Southern Africa
Honeywell S.A. Pty. Ltd.
Phone: +27 11 6958000
Fax: +27 11 6958000

**NORTH AMERICA**

**Canada**
Honeywell LTD
Phone: 1-800-737-3360
Fax: 1-800-665-4130

**USA**
Honeywell Process Solutions,
Phone: 1-800-343-0228
Fax: 1-717-771-8251
Email: sc-cp-appssales@honeywell.com

**LATIN AMERICA**

**Argentina**
Honeywell S.A.C.
Phone: +(54-11) 4383-3637
Fax: +(54-11) 4325-6470

**Brazil**
Honeywell do Brasil & Cia
Phone: +(55-11) 7266-1900
Fax: +(55-11) 7266-1905

**Chile**
Honeywell Chile, S.A.
Phone: +(56-2) 233-0688
Fax: +(56-2) 231-6679

**Mexico**
Honeywell S.A. de C.V.
Phone: +(52) 55 5570-2985
Fax: +(52) 55 5570-2985

**Puerto Rico**
Honeywell Inc.
Phone: +(787) 792-7075
Fax: +(809) 792-0053

**Trinidad**
Honeywell Inc.
Phone: +(868) 624-3964
Fax: +(868) 624-3969

**Venezuela**
Honeywell CA
Phone: +(58-2) 238-0211
Fax: +(58-2) 238-3391